
EXERCICI 1 
 País Valencià:  

Densitat municipal  



A l’arxiu València_muni_coma  li assignem una simbologia amb nou intervals de densitat: 
Valencia_coma_muni, Properties, Simbology, Quantities, Graduated Colors, Value: Densitat 
Classes: 9. Aneu a Classify... 



Classification: Method: Manual. Li assignem 9 intervals: comencem per 25 i anem en progressió 
geomètrica: 25x2 = 50; 50 x 2 = 100; 100 x 2 = 200; 200 x 2= 400; escrivim els valors en Break 
Values, com es veu en pantalla (per escriure, amb el botó esquerre seleccionem el valor i 
escrivim 25, 50, 100, 200, 400, 800 i l’últim valor (26627) el deixem intacte. Cliquem en OK. 



En el quadre de diàleg Layer 
Properties eliminem els 6 
decimals assignats per 
defecte: cliquem amb el 
botó esquerre en la 
pestanya Label  i en Format 
Labels; en 
Number of decimals places 
li diem 0.   



En el quadre de diàleg Layer 
Properties eliminem la vora 
negra dels colors rojos. 
Cliquem en la pestanya Symbol, 
i amb el botó esquerre, en 
Properties for All Symbols; 
Outline Color: No Color. 



El mapa quedarà així. L’escala de referència serà 
1:1.150.000. Amb el botó esquerre cliquem i en 
Distribute despleguem finestra i li diem Fit to 
Margins. Passem a inserir (insertar) les 
etiquetes, de la manera següent.  



Passem el mapa a vista Layout. L’escala de referència serà 1:1.150.000.  
Etiquetes (labels): en Method li diem Define classes of features and labels each class differently 
i passem a assignar-li unes característiques generals per a totes les classes, que són:  
 
1. Placement propeties, placement, cliquem en remove duplicate label 
2. Placement properties, conflcit detection, place overlapping labels 
 
Eliminar etiquetes duplicades és perquè alguns municipis estan disgregats en diferents 
polígons, i així ens assegurem que només isca (salga) un label per cada municipi. 
Col·locar les etiquetes que es xafen (se pisan) és perquè per defecte el programa les elimina 
arbitràriament i nosaltres les volem conservar.    
 
A continuació, creem 3 classes de labels: 25, 50 i 100 (vegeu diapositiva següent): 
En 25 anem a SQL i li assignem “població”>25000 i “població” < 50000, lletra 8. 
En 50_100 anem a SQL i li assignem “població”>50000 i “població” < 100000, lletra 10. 
En 100_250 anem a SQL i li assignem “població”>100000, lletra 12. 
 
En cada classe cliquem en Label Features in this class, però descliquem (o eliminem: delete) la 
classe Default, cliquem en Label Features in this layer. 





El mapa quedarà així. Com que les etiquetes es xafen, les arreglarem manualment. 
Ens assegurem que estem en l’escala 1:1.200.000, premem (pulsamos) en Convert Labels to 
Annotation, cliquem In the Map, Convert. 



Modifiquem manualment les etiquetes i evitem que se solapen. 



A continuació afegim (añadimos) llegenda, nord, escala numèrica i gràfica. 



Finalment, cal anar a File, Export Map 
(en format jpeg (300 pxp) o en pdf) i 
aquesta imatge cal enviar-la a 
Tasques, exercici 1. 
 
Juntament amb el mapa cal enviar un 
informe en Word d’entre 15 i 20 línies 
amb la descripció dels fenòmens 
geogràfics que hi ha al mapa: 
 
Esquema d’informe: 
 
...en aquest mapa observem que a la 
zona litoral …, mentre que a l’interior 
…, i en l’eix que va de ... a ... es 
troben... 



EXERCICI 2 
 Espanya:  

Densitat municipal  



A l’arxiu espanya_munibo li assignem una simbologia amb deu intervals de densitat: 
Espanya_munibo, Properties, Simbology, Quantities, Graduated Colors, Value: Densitat 
Classes: 10. Aneu a Classify... 

Classification: Method: 
Manual. Li assignem 10 
intervals: començant per 
12,5 i anant en 
progressió geomètrica: 
12,5 x2 = 25; 25 x 2 = 50; 
50 x 2 = 100; etc. 
Escrivim els valors en 
Break Values, com es 
veu en pantalla (per a 
escriure, amb el botó 
esquerre seleccionem el 
valor i escrivim 12,5, 25, 
50, 100, 200, 400, 800. 
1600, 3200 i l’últim valor 
el deixem intacte. Li 
diem OK. 



En el quadre de diàleg Layer Properties deixem només un dels 6 decimals assignats per 
defecte: cliquem amb el botó esquerre en la pestanya Label  i en Format Labels; en 
Number of decimal places li diem 1.   



En el quadre de diàleg Layer Properties eliminem la vora negra dels colors rojos. 
Cliquem en la pestanya Symbol i amb el botó esquerre marquem Properties for All 
Symbols; Outline Color: No Color. 



El passem a vista Layout. L’escala de referència serà 1:5.000.000. Si el mapa apareix en 
format vertical, anem a File, Print and Page Setup cliquem en Landscape, no en Portrait.  
Passem a inserir (insertar) les etiquetes, de la manera següent. 



En Method li diem Define classes of features and label each class differently i passem a 
assignar-li unes característiques generals per a totes les classes, que són:  
 
1. Placement propeties, placement, click en remove duplicate label. 
2. Placement properties, conflcit detection, place overlapping labels. 
 
Eliminar etiquetes duplicades és perquè alguns municipis estan disgregats en diferents 
polígons, i així ens assegurem que només isca (salga) un label per cada municipi. 
Col·locar les etiquetes que es xafen és perquè per defecte el programa les elimina 
arbitràriament i nosaltres les volem conservar.    



A continuació creem 5 classes de labels: 100; 200, 400, 800, 1600, 3200 
En 100 anem a SQL i li assignem “població”>100000 and  “població” < 200000, lletra 8. 
En 200 anem a SQL i li assignem “població”>200000 and  “població” < 400000, lletra 9. 
En 400 anem a SQL i li assignem “població”>400000 and  “població” < 800000, lletra 10. 
En 800 anem a SQL i li assignem “població”>800000 and  “població” < 1600000, lletra 12. 
En 1600 anem a SQL i li assignem “població”>1600000 and  “població” < 3200000, lletra 14. 
En 3200 anem a SQL i li assignem “població”>3200000, lletra 16. 
 
En cada classe cliquem en Label Features in this class, però descliquem (o eliminem) la classe 

Default. Ens assegurem que en Label field hi ha el camp nom. Cliquem en Label Features in 
this layer. 



En algunes zones molt poblades les etiquetes se superposen les unes a les altres. 
Les hem de desplaçar a mà per col·locar-les de manera que siguen legibles. 
  
Assegurant-nos que estem en l’escala 1:5.000.000, cliquem en Convert Labels to Annotation, 
cliquem en In the Map, Convert. 
Com que les etiquetes es xafen, a les àrees metropolitanes de Madrid i Barcelona llevem 
(quitamos) manualment els municipis entre 100 i 200.000 habitants que ens destorben. 
Manualment desplacem els municipis costaners fora del mapa (a la zona marítima). 



A continuació afegim (añadimos) llegenda, nord, escala numèrica i gràfica. 



No ens oblidem de les Canàries, que no apareixen en el mapa. 
Creem un nou Data Frame: Insert, Data Frame.  
El col·loquem en el cantó sud-est del mapa. 
Arrosseguem la capa espanya_munibo des del Data frame principal (Layers) al nou Date 
Frame, al qual anomenem Canàries. Col·loquem Canàries en el centre aproximat del 
rectangle. Li donem escala 1:5.000.000. Centrem les illes Canàries (si cal, donem toponímia). 



Finalment, cal 
anar a File, 
Export Map 
(en format tiff, 
jpeg o en pdf) i 
aquesta 
imatge la 
guardem en la 
carpeta 
Tasques de 
l’aula virtual, 
exercici 2. 

A continuació, afegim (añadimos) llegenda, nord, escala numèrica i gràfica. 

Cal fer un informe com el que vàreu fer per a l’exercici 
1, aplicat a Espanya. El mapa ha de quedar més o 
menys com el d’aquesta diapositiva. 



A continuació, afegim 
(añadimos) els mapes de 
Portugal, França, el Marroc 
i Algèria. No disposem de 
cap shapefile adequat i, per 
tant, els contorns dels 
estats fronterers els 
dibuixarem nosaltres a mà, 
basant-nos en qualsevol 
mapa d’Internet, on 
apareguen els límits ben 
definits. Entrem en Google i 
escrivim “España mapa”. 
Seleccionem un mapa amb 
els contorns dels estats 
veïns. Aquesta imatge la 
guardem en el nostre arxiu. 

Per a pujar nota: busquem en Internet un mapa d’Europa. 
Capturem la imatge (jpg). L’afegim (add data) com una capa més. 
La georeferenciem (Fit to Display). Hi dibuixem Portugal, França, el Marroc. 
Hi posem la mar. 



Vinculem (Add data) Fronterers.jpg → Fem un zoom whole page en Espanya_munibo→ 
Mostrem la barra georeferencing → Despleguem georeferencing (en la finestra layer ha de dir: 
fronterers.jpg (en la diapositiva diu → mapaprovincias) → cliquem sobre Fit to Display. El mapa 
fronterers se’ns col·loca aproximadament sobre Espanya_muni. 



Nosaltres georeferenciem a mà (amb l’Add Control Points) la imatge per col·locar-la 
perfectament sobre Espanya_munibo → ens col·loquem sobre punts geogràfics eminents (caps 
costaners, zones de frontera) → amb el botó esquerre col·loquem l’Add Control Point sobre el 
Cap de la Nau de la imatge jpg → el desplacem i amb el botó esquerre col·loquem l’Add Control 
Point en el Cap de la Nau del shapefile → Fem el mateix amb uns quants punts de control més 
fins que la imatge i el shapefile coincidisquen el màxim possible.   

Add Control Points 



Una vegada georeferenciada, dibuixarem Portugal, França, el Marroc i Algèria en l’arxiu espanya_muni.



Amb la barra editor > start editing > Task: autocomplete polygon > Target: Espanya_muni > 
snapping (que trobem en desplegar la barra Editor) ha d’estar activat.   
Dibuixem les siluetes de Portugal, França i el nord d’Àfrica amb l’Sketch Tool. 

Sketch 

Tool 



Després seleccionem els tres polígons dibuixats i els exportem amb l’eina Data > Export Data → 
que es troba clicant amb el botó dret sobre espanya_munibo → creem un arxiu nou, que es dirà 
fronterers.shp i li donem un color apropiat discret, diferent d’Espanya_muni. 



El mapa ha de quedar més o menys com el de la diapositiva següent:  



EXERCICI 3 
Mapa demogràfic municipal 

del País Valencià 
(símbols proporcionals) 



1. Obrim ArcMap. 
2. Carreguem el shape 
Valencia_muni_coma de 
l’aula virtual. 
3. Amb el botó dret sobre 
Valencia_comq_muni cliquem 
en properties, simbology, 
quantities, proportional 
symbols.  
4. En fields li donem el value 
població. 
5. En Min. Value li donem 0,3.
   
6. Color = roig intens (mars 
red). 
1. Aneu a BACKGROUND. 
2. Fill Color = color clar (Yucca 
Yellow, Olivine Yellow). 
3. Outline Width = 0,1.  
4. Outline Color = negre. 
5. Number of Symbols to 
display in the Legend = 10. 
 



A continuació anem a Insert > Data frame i crearem un new data frame. 
Objectiu: separar la comarca de l’Horta de la resta del territori. 
Mostrar l’Horta a una escala menor (menor escala = es veu més gran).  



Arrosseguem (arrastramos) el mapa Valencia_muni_coma a l’altre data 
frame, li donem escala 1:500.000 al new data frame i situem l’Horta en el 
centre del new data frame. Agafem l’arxiu Valencia_muni_coma i en fem 
una còpia (Data > Export Data) i la guardem en la carpeta exercici_03 del 
nostre pendrive i li diem valencia_muni2. Després l’arrosseguem i la 
passem també al new data frame. 



En el layer principal convertim les features (elements) en gràfics. Per què?
Perquè els gràfics es poden manipular, però els elements, no. Ens interessa 
poder manipular-los (desplaçar-los). Ara bé, només convertirem a gràfics 
aquells elements que no siguen de la comarca de l’Horta.  



Per a seleccionar aquells elements que no són de l’Horta anem a Open 
attribute table > Options > Select by Attributes > “comarca” <> “Horta”. 
Selecciona tots els elements diferents de comarca Horta.  



Ens assegurem que Valencia_muni està desactivat. Ens assegurem que en 
Convert Features to graphics només convertim selected i only draw the 
converted graphics (els dos ixen per defecte) > Ok. 



En convertir a gràfics ens ha desaparegut la línia dels termes. Per 
recuperar-la cal activar el mapa Valencia_muni2. A continuació, volem 
diferenciar el color de l’Horta, que no te cap element, del color de la 
resta de municipis.  



Anem a symbology de valencia_muni2 > categories > add values > add 
Horta > color groc (yellow) Horta i color verd clar la resta de municipis. 



Anem a centrar-nos en el New Data Frame. Per a Convert Features to 
Graphics, primer seleccionem només les features de l’Horta > open 
attribute table > options > select by attributes > “comarca” = “Horta”.    



Després, Convert Features to Graphics > ok. 



Desapareixen els termes, però si activem Valencia_muni2, ens tornen a 
aparèixer. En Valencia_muni2 diferenciem els colors de l’Horta dels de la 
resta de comarques. 



Canviem l’escala del New Data Frame a 500000. Així l’Horta es veurà més gran.



Ara ens centrem en el new layer. Traiem (sacamos) el cercle de la ciutat 
de València a la mar. 



Per a col·locar la toponímia (labels), en Layer properties > Labels > 
Placement properties > remove duplicate labels & place overlapping 
features; SQL Query > “comarca” = “Horta” AND “població” > 25000. 
Etiquetarà només els municipis de l’Horta amb més de 25.000 habitants.  



Ara hem de passar la toponímia de label (no editable) a annotation 
(editable).  



Separem les anotacions toponímiques. A València li donem 14, i a 
Paterna i Manises, que tenen més de 50.000 habitants, els donem 10. 



Ara ens centrem en la toponímia del layer principal. Anem a labels 
(Remove Duplicate Labels, and Place Overlapping Labels) i seleccionem 
amb l’SQL els municipis que “comarca” <> Horta AND “població” > 25000. 
Etiquetarà els municipis de fora de l’Horta amb més de 25000 habitants. 



Convert Labels  to Annotations > In the map > Scale: 1.150.000 > Convert. 



Ara manipulem les labels, especialment a la zona de Castelló i Alacant. 
A Alacant li donem 12 punts. A Elx, Castelló i Torrevella, 11. A Vila-real, 
Sagunt, Gandia, Benidorm, Alcoi, Elda i Oriola (tots passen de 50.000 
habitants) els donem 10 punts. 



 
La llegenda és massa gran. Cal 
esborrar elements innecessaris, fins 
que es quede així: 
Cal anar jugant amb Properties, 
Group, Ungroup. 
 



Posem llegenda, nord, 
escala, títol, etc. i 
pugem el mapa a 
Tasques. El mapa final 
hauria de quedar com 
els de la imatge. 



Exercici 5 
 

Com crear un mapa de percentatge de 
població estrangera en València sense 

dades de partida 



Anem a la pàgina web de l’INE 
<http://www.ine.es/> 

 
INE Base > Demografía y población > Cifras de población y censos 

demográficos > Padrón municipal > Explotación estadística del Padrón > 
 Datos por municipio (entra en Tablas INE Base) > 

 
Per si no heu arribat, vos passe tot l’enllaç: 

<http://www.ine.es/jaxi/menu.do?type=pcaxis&path=%2Ft20%2Fe245&f
ile=inebase&L=> 

 
 Aneu a Datos por municipios > seleccione un año (2010) > Ir >  

 
03. Alicante/Alacant > 03.2 Población por sexo, municipios, nacionalidad 

(español/extranjero) y edad (grandes grupos)  
 

12. Castellón/Castelló > 12.2 Población por sexo, municipios, nacionalidad 
(español/extranjero) y edad (grandes grupos)  

 
46. Valencia/València >  46.2 Población por sexo, municipios, 
nacionalidad (español/extranjero) y edad (grandes grupos)  

 
 

http://www.ine.es/jaxi/menu.do?type=pcaxis&path=/t20/e245&file=inebase&L
http://www.ine.es/jaxi/menu.do?type=pcaxis&path=/t20/e245&file=inebase&L
http://www.ine.es/jaxi/tabla.do?path=/t20/e245/p05/a2010/l0/&file=00003002.px&type=pcaxis&L=0
http://www.ine.es/jaxi/tabla.do?path=/t20/e245/p05/a2010/l0/&file=00003002.px&type=pcaxis&L=0
http://www.ine.es/jaxi/tabla.do?path=/t20/e245/p05/a2010/l0/&file=00012002.px&type=pcaxis&L=0
http://www.ine.es/jaxi/tabla.do?path=/t20/e245/p05/a2010/l0/&file=00012002.px&type=pcaxis&L=0
http://www.ine.es/jaxi/tabla.do?path=/t20/e245/p05/a2010/l0/&file=00046002.px&type=pcaxis&L=0
http://www.ine.es/jaxi/tabla.do?path=/t20/e245/p05/a2010/l0/&file=00046002.px&type=pcaxis&L=0
http://www.ine.es/jaxi/tabla.do?path=/t20/e245/p05/a2010/l0/&file=00046002.px&type=pcaxis&L=0


Seleccionem: ambos sexos + tots els municipis + total/españoles/extranjeros + total/menores de 14/ 
De 16 a 64/más de 65 > Consultar selección     



Una vegada ja tenim la selecció en una taula anem a Descargar como > Excel > Ir > guardem la 
taula com taula_alacant, fem el mateix amb Castelló (taula_castello) i València (taula_valencia). 



Obrim respectivament taula_alacant, taula_castello i taula_valencia i els netegem, llevant-los 
totes les files innecessàries del principi i del final (també llevem el total provincial).  

Ha de quedar com la imatge.  
Fem el mateix per a taula_alacant i taula_castelló, i després fusionem els tres arxius, però 

només mantenim un encapçalament (encabezamiento) (Ambos sexos/total/menores/ etc.) per 
a la suma de les tres províncies. En la taula final quedaran 542 municipis i 1 encapçalament. 



Anomenem la taula nova taula_totval. Ens col·loquem en la casella N2 i hi apliquem la 
fórmula EXTRAE(A2;4;5) i arrosseguem cap a vall (arrastramos hacia abajo). La intenció es 
separar el codi INE del nom del municipi. Amb el codi INE podrem fer un encreuament de 
dades (cruce de datos) amb les dades del nostre mapa SIG muni_habitants (carpeta 
Espanya).  



Ara cal centrar-nos en quin tipus de mapa volem representar: el primer que ens interessa serà 
el de nombre d’estrangers residents al País Valencià per municipis. En la casella O apliquem 
La fórmula J2*100/B2, on J2 són els estrangers i B2, el total d’habitants. Així, trobarem el 
percentatge d’estrangers. Després arrosseguem cap avall per als 542 municipis. 



Seleccionem les columnes N i O, les copiem i les inserim (insertamos) en un full de càlcul nou 
amb la finalitat de treballar de manera més clara i senzilla.  



Quan l’enganxem en Hoja 1 li hem 
de dir pegado especial valores o pegar valores. Eliminem la fila 1 i desplacem cap amunt 
les altres 542 files. Ens han de quedar 542 valors. Després ja tenim la taula perfecta per a 

importar-la des d’Acces. 
Obrim l’Access.  



Obrim Access i li diem base de datos en blanco. Nom de l’arxiu: estrangers. Nuevo > 

importar tabla > tipo de archivo: Microsoft Excel > busquem taula_totval. En 
mostrar hojas de trabajo seleccionem Hoja 1 > siguiente: descliquem Primera fila 

contiene el título de columas > siguiente > siguiente: nombre del campo codi > siguiente 
> siguiente > importar a la tabla estrangers > finalizar.  



Anem a l’arcGIS i a partir de muni_habitants seleccionem els municipis de València. Podem fer-
ho mitjançant Select by Attributes where "COM" = '02‘. Si només tinguérem el codi municipal i 

no l’autonòmic, aplicaríem la fórmula següent: 
Select by Attributes where 

“codi” LIKE ‘12%’ OR “codi” LIKE ‘03%’ OR “codi” LIKE ‘46%’. 



Després, sobre el layer muni_habitants, amb el botó dret cliquem en Data > Export Data > i 
guardem com a estrangers. 



Després, ens col·loquem en la pestanya de visualització source de la Table of Contents i Add Data 
> afegim la taula d’Access estrangers.  



A continuació, passem a fer un join de la base de dades d’Access estrangers amb el shapefile 
estrangers. Un join és una unió de dues taules que tenen un camp en comú, en aquest cas, el 

camp codi, tant en una taula com en l’altra. 



Botó dret sobre shapefile estrangers. Joins and Relates > join.  
En Choose the field in this layer that the join will be based on li diem codi.  

En Choose the field in the table to base the join on li diem codi.   



El join ha unit momentàniament les dues taules mitjançant (mediante) un camp compartit per 
les dues. Ara amb el botó dret Data > Export Data i creem un nou shapefile que es dirà 

estrangers2. 



El join d’estrangers el podem llevar (remove joins). Ara només treballarem amb estrangers2, des 
del qual crearem un mapa de proporció de població estrangera per municipi i que presentarem 

adequadament i penjarem en la carpeta Tasques de l’aula vitual, exercici 5.  





Exercici 6 
Mapa de mitjanes de precipitació 

Isohietes 
(Isohieta (isoyeta): corba que uneix punts, en un plànol cartogràfic, que 

presenten iguals intervals de precipitació expressada en la unitat de temps 
considerada.) 



Carreguem (add data) el shape shape_pluges (vectorial) i la imatge imatge_pluges (ràster). 
Aquesta darrera representa les precipitacions mitjanes anuals de tots els municipis 
valencians, en litres per metre cúbic (o el que és el mateix, en mm3).  
 Sobre el mapa shape_pluges de l’aula virtual dibuixarem les isohietes. 



Donem coordenades a shape_pluges. 
 



Centrem shape_file en la finestra de vistes. 
Després, a Georeferencing li diem Fit to Display i col·loca imatge_pluges aproximadament 
darrere de shape_pluges.  



Amb el botó Add Control Points ens col·loquem sobre un punt ben recognoscible del mapa 
(extrem NE), cliquem el botó esquerre del ratolí i el traslladem al mateix punt del mapa amb 
coordenades (també botó esquerre).  



Fem el mateix amb altres dos punts. 



La imatge_pluges es col·loca just damunt del shape_pluges.  



Ara ja tenim en les mateixes 
coordenades shape_pluges i  
imatge_pluges. Ara ja podem 
començar a dibuixar sobre 
shape_pluja les dades de 
imatge_pluges. 
Mostrem la barra Editor. Li diem 
start editing. A partir d’un únic 
polígon amb la silueta de 
València, separarem zones 
d’igual interval de precipitació 
mitjançant l’eina de tallar (cut). 
Separarem zones amb intervals 
entre 200 i 300 mm, entre 300 i 
400, i així fins a zones de 800 a 
900. 
La imatge_pluges, que conté els 
registres de pluja anual en mm3 
per municipi i els colors que 
representen les isohietes a 
escala municipal (en intervals de 
200 a 300, 300 a 400, etc.), serà 
la nostra referència. 



Amb cut retallem les àrees d’igual 
interval de precipitació, però no seguint 
estrictament els termes municipals, sinó 
fent línies corbes menys sinuoses.  
Cal tenir en compte que el registre de 
precipitació que es mostra només 
correspon a un punt, la pluja de la 
capital municipal, que sol situar-se en el 
centre del terme.  
Sempre ha d’haver una zona de 
transició entre un interval i un altre. Per 
exemple: Vistabella té 724 mm3 
(interval 700-800 mm3) i el seu veí 
oriental Culla 592 (interval 500-600 
mm3). Entremig no hi ha l’interval 700-
800. Caldrà crear-lo intuïtivament.  
 
 Vistabella  Culla 



Quan hi haja una zona interior que 
calga tallar no es pot emprar cut, sinó 
create new feature. Després de fet el 
create cal immediatament fer un clip 
per damunt, que evitarà polígons 
duplicats. 
  
Una vegada ja hem retallat totes les 
àrees d’igual precipitació, passem a 
assignar-los el valor que els 
corresponga.  



Una vegada ja hem retallat totes les 
àrees d’igual precipitació, passem a 
assignar-los el valor que els 
corresponga.  



En el camp pluges 
escrivim la precipitació de 
cada isopleta (àrea d’igual 
precipitació):  
a les zones de precipitació 
entre 200 i 300 mm3 li 
assignem el valor 300,  
a les zones entre 300 i 
400, el valor 400, i així 
fins a les zones entre 800 i 
900, amb el valor 900.  



Passem a representar la 
simbologia.  
Li assignem manualment 7 
intervals, començant per 300 i 
acabant per 900. Eliminem 
decimals i contorns d’interval.  



Passem a etiquetar el mapa.  
 
Cal vincular un nou arxiu que tinga el nom 
dels termes municipals 
(Valencia_muni_coma).  
 
No ens basarem en els municipis de més 
població sinó en les capitals de comarca, 
així ens assegurem que tot el territori, amb 
totes les varietats climàtiques, mostrarà 
alguna etiqueta pròxima. 
 
Per a etiquetar les comarques, sobre 
properties, labels de Valencia_muni_coma 
posarem les capitals de comarca. Crearem 
un grup en Define classes of features and 
label each class differently i li direm 
cap_comarca. En el SQL query direm Select 
from Valencia_habitants where:   
“nom” = ‘Ademuz’ OR “nom” = ‘Alacant’ 
OR “nom” = ‘Albocàsser’, etc. i així fins a 
totes les capitals de comarca. Per trobar les 
capitals de comarca entre els 542 
municipis ens ajudarem del Go To. 



Les capitals de comarca són les següents: 
Vinaròs, Morella, Albocàsser, Castelló, 
l’Alcora, Borriana, Cirat, Sogorb, Ademús, 
Xelva, Llíria, Sagunt, Requena, Chiva, 
València, Sueca, Alzira, Enguera, Aiora, 
Xàtiva, Ontinyent, Gandia, Dénia, Alcoi, 
Cocentaina, Villena, la Vila Joiosa, 
Alacant, Elx, Elda, Oriola. També posarem 
Torrevella, Benidorm, Novelda i Calp, com 
a ciutats importants no capital de 
comarca. També podem situar unes altres 
poblacions amb registres de precipitació 
significatius, com ara Pego, Bunyol, 
Vistabella, Rossell o Crevillent. 



Després posem 
llegenda, escala i 
títol, fem el 
comentari i l’enviem 
a exercici_06 de la 
carpeta Tasques. 



Exercici 7 
Mapa de procedència dels 

immigrants estrangers al País 
Valencià per comarques 

 



Anem a la pàgina web de l’INE 
<http://www.ine.es/> 

 
INE Base > Demografía y población > Cifras de población y censos 

demográficos > Padrón municipal > Explotación estadística del Padrón > 
 Datos por municipio (2011) > Población por sexo, municipios y 

nacionalidad (principales nacionalidades) 
 

 Aneu a >  
 

03. Alicante/Alacant > Población por sexo, municipios y nacionalidad 
(principales nacionalidades) 

 
12. Castellón/Castelló > Población por sexo, municipios y nacionalidad 

(principales nacionalidades) 
 

46. Valencia/València >  Población por sexo, municipios y nacionalidad 
(principales nacionalidades) 

 
 
 



Seleccionem: ambos sexos + tots els municipis + Nacionalidad: Total UE + Bulgaria + Polonia + 

Rumanía + Total Europa no comunitaria + total África + total America + total Asia > Consultar 

selección     



Obrim respectivament taula_alacant, taula_castello i taula_valencia i els netegem, llevant-los totes 

les files innecessàries del principi i del final (també llevem el total provincial). Ha de quedar com la 

imatge de baix. Després fusionem els tres arxius, però només mantenim un encapçalament 

(encabezamiento) (Total UE/Bulgaria/Polonia/Rumanía/Total Europa no comunitaria/total 

África/total América/total Asia) per a la suma de les tres províncies. En la taula final quedaran 542 

municipis i l’encapçalament. 

Una vegada ja tenim la selecció anem a Descargar como > Excel > Ir > guardem la taula com 

taula_alacant, fem el mateix amb Castelló (taula_castello) i València (taula_valencia). 



Anomenem la taula nova taula_totval. Ens col·loquem en la columna J, casella J2 i li apliquem 

la fórmula B2-C2-D-E2, és a dir, UE menys Bulgària, Polònia i Romania (països de la UE però 

no de l’euro i, per tant, pobres) i arrosseguem cap avall (arrastramos hacia abajo). La intenció 

és separar la UE rica (columna J) de la UE pobra.  



Ens col·loquem en la columna K casella K2 i li apliquem la fórmula B2-J2+F2. Al total de la UE 

li llevem rica li llevem la suma dels països pobres (J2) i després li sumem els països 

extracomunitaris (principalment Ucraïna i Rússia). D’aquesta manera tenim diferenciades 

l’Europa rica columna J) i l’Europa de l’est (columna K).  



Ara ens col·loquem en la columna L, casella L2 i li apliquem la fórmula EXTRAE(A2;4;5) i 

arrosseguem cap avall (arrastramos hacia abajo). La intenció és separar el codi INE del nom 

del municipi. Amb el codi INE podrem fer un creuament de dades (cruce de datos) o join amb 

les dades del nostre shapefile Valencia_muni_coma.  



El tipus de mapa que volem representar consisteix a diferenciar els estrangers per comarques 

valencianes en funció de la seua àrea d’arribada. Les àrees possibles seran 5: Àfrica, Amèrica, 

Àsia, UE rica (estrangers que vénen per plaer) o UE pobra (estrangers que vénen a treballar). 

Seleccionem i copiem les caselles de la columna G a la L i les portem a una nou full (full1). Així 

podrem treballar exclusivament amb les columnes que ens interessen. 



Quan enganxem les dades en full1 cal dir enganxa els valors.  

Ordenem el Full 1 com es veu en la imatge: codi/UE rica/UE pobra/Amèrica/Àfrica/Àsia.  

Ara ja tenim la taula Excel. Només ens cal (fonamental) desar (guardar) la taula Excel com a Excel 

2003, sino, l’arcGIS no el reconeix. 

Una vegada desada com a 2003, ja tenim l’Excel a punt per a ser importat des d’Access. Guardem 

l’Excel en la carpeta corresponent del nostre pendrive i el tanquem. Obrim a continuació l’Acess.  



Obrim Access i anem a Abrir base de datos reciente > Más (on cliquem), 

mostrem Todos los archivos (no només els d’Access). Busquem la taula Excel 

en el nostre pendrive i importem. En mostrar hojas de trabajo seleccionem Full 

1 > siguiente: mantenim clicada Primera fila contiene encabezados de columa > 

siguiente > siguiente: nombre del campo codi > siguiente > siguiente > importar 

a la taula Full1 > finalizar. Desem (guardamos) l’Access en versió 2003 (no 

2007). L’extensió ha de ser .mdb i no .accdb. 



Anem a l’arcGIS i obrim el mapa Valencia_muni_coma (aula virtual mapes València), 

on hi ha les comarques i els codis municipals. Obrim també la taula Full1 dins de la 

base de dades proc_estrang. Fem un join de les dues bases a partir de codi. 



Exportem el join de Valencia_coma_muni (data, export data) i el guardem com a 

proc_estrangers, on tindrem el codi municipal, el nom del municipi, el nom de la comarca i la 

procedència dels estrangers (UE, Europa Est, Amèrica, Àfrica, Àsia). Mostrar les dades municipals 

seria excessiu i faria el mapa il·legible. Tanmateix, podem mostrar les dades comarcals, que sí que 

permeten llegir-lo. Com podem fusionar les dades dels municipis en dades comarcals? 



Obrim l’Arc Toolbox i en la pestanya de baix Index escrivim dissolve, que és una funció de l’Arc 

Toolbox que ens farà automàticament la reducció dels municipis en comarques. 

Cliquem dues vegades sobre Dissolve (management) i se’ns obrirà aquest quadre de diàleg. 



En Input Features despleguem la pestanya i seleccionem proc_estrangers. 

En Output Features crearà un arxiu que es diu proc_estrangers_Dissolve.shp. I el guardarem en 

la carpeta que corresponga (li direm la ruta, si cal). 

En Dissolve Field(s) cliquem la casella de comarca, així integrarà (“dissoldrà”) tots els municipis en 

funció de la comarca on pertanyen (donde pertenecen) les caselles.  



En Statistical Field(s) li diem les cinc procedències agrupades (UE_euro; 

UE_Est;Total_Amér;Total_Àfr; Total_Àsia) i en el Statistic Type despleguem la pestanya i li diem 

SUM (suma) en tots els casos. Dissolve dissoldrà els municipis en comarques però també sumarà 

els estrangers de cada municipi i els agruparà per comarques. Li diem OK. 



Ens mostra les dades per comarques, i dins de cada comarca els camps UE_euro, UE 

est, Amèrica, Àfrica i Àsia.  



Passem el mapa a vista layout i li posem l’escala 1:1200000. Si la finestra de l’escala 

està bloquejada, anem a Layers i en la pestanya General, on diu Unknown Units li diem 

Meters. Passem a la simbologia. 



Anem a Symbology. Li diem Charts > Pie. En Field Selection marquem (amb la fletxa) 

els cinc grups de procedència d’estrangers, que passaran a la casella Field. En Symbol 

assignem el blau a la UE (per la bandera europea), el roig a l’Europa de l’est (per 

l’antiga bandera comunista russa i pel roig de les banderes de Romania i Bulgària), el 

groc (amarillo) a Amèrica pel groc de les banderes d’Equador, Colòmbia i Bolívia. El 

verd a Àfrica, pel verd dels països musulmans i un color claret a Àsia (Yucca Yellow) 

perquè estan agafats tots els altres colors.  

Fixa’t en el botó Size (veieu diapositiva següent).  



Cliquem el botó Size i marquem el cercle que diu Vary size using the sum of the field 

values. Així, no només ens eixiran els formatgets (tartas) amb la procedència dels 

estrangers, sinó també la quantitat d’estrangers per comarques.  

En Min Value en el Size escriurem 5 pts. 



El mapa eixirà com es veu la imatge. Ara posem labels, títol, llegenda, escala i nord. 

El mapa ha de quedar semblant al que hi ha en la diapositiva següent.  



Fes el comentari i 

envia’l a Exercici_7. 



Anem a fer un mapa d’exportacions des d’Espanya o des d’una comunitat atònoma espanyola cap 

a l’exterior. Entrem en la pàgina web de l’ICEX (Instituto de Comercio Exterior de España). Cliquem 

sobre Estadísticas de Comercio Exterior.  

Anem a les Estadísticas españolas de comecio exterior > Acceso a productos. 

Exercici 8. Mapa de fluxos 
 



Anem a ESTACOM. Anem a Acceso al servicio. Ens demanarà usuario i contraseña. Escrivim 

l’usuari i la contrasenya que hem dit a classe. 

 



Entrem en RANKING DE PAÍSES 

En Selección de Provincias seleccionem Comunitat Valenciana i Flujo = Exportación. 

En Selección de Países triem els 30 primers (Nº de Términos = 30) Año = 2010 (de Enero a 

Diciembre). En Selección de Productos triem el 30108 Pavimentos y Revestimientos Cerámicos 

Cadascú ha de triar el territori, el producte i l’any que preferisca (per exemple, si esteu fent un 

treball de geografia sobre el calcer, triaríeu calzado i no pavimentos. O sobre taronges, joguets…). 



A l’esquerra veiem l’aspecte de l’informe que hem demanat sobre paviments i revestiments 

ceràmics. El passem a Excel, en prémer el botó (encerclat en roig). Cal que hi haja una 

coincidència entre els topònims (Francia, Rusia, etc.) d’Excel (i Access) amb els d’arcGIS. Per 

això hem de fer una neteja (limpieza) i eliminar els codis de cada país. En la imatge veiem com 

eliminar els codis perquè es queden nets els topònims. 



A l’esquerra veiem l’aspecte de la taula Excel després d’haver-la netejada i ordenada de major a 

menor. Si volem fer el mapa de fluxos amb arcGIS cal que el passem a Access (dreta) i que hi 

haja una coincidència EXACTA entre els topònims (Francia, Rusia, etc.).   



ArcGIS: obrim el programa i vinculem el mapa de l’aula virtual > mapes > món > 

Europa_world. Fem un join amb l’Access que hem obtingut anteriorment i creem un nou 

shape que es dirà cera_world. Comprovem que els 30 topònims de països dels shapes es 

corresponen amb els 30 topònims de l’Access. Si hi ha cap discrepància (majúscules, accents, 

etc.), la resolem a mà. Creem un camp nou (grossor)(1) on dividim els milions d’euros per 

100000 (aquesta constant pot variar en funció del sector que hàgeu triat, per a taulells 100000 

és adequada). El camp grossor serà la mida que usarem per a cada línia de fluxos en el nostre 

mapa. A més, creem un shapefile (amb ArcCatalog) de tipus polyline (línia) i li diem línia (2). 

2 1 



Com que la majoria de les exportacions van a països europeus, anem a treballar amb 

dos Data Frames i dues escales distintes: una per a Europa i la Mediterrània (escala 

1:45.000.000) i una altra per a la resta del món (escala 1:80.000.000). 



La primera cosa que farem serà dibuixar en l’arxiu línia (del Data Frame Europa) un 

cercle al voltant del País Valencià (1). El cercle el dibuixem amb el Circle Tool de la 

barra Advance Editing (2). Una vegada fet i quan encara està en mode selecció (perquè 

està il·luminat en blau) el convertim en gràfic (3). 

1 

2 

3 



Després desseleccionem el cercle i amb la fletxa Select Elements (1), cliquem dues o 

més vegades sobre el gràfic fins que se seleccione i s’òbriga la finestra properties.  

Li donem color Negre (2) i Width (amplària) = 12 (3).  

Situem el cercle sobre el País Valencià (4). 

2 

3 

4 



A continuació, comencem a 

dibuixar les línies de fluxos. 

Ens situem sobre la ratlla 

que hi ha baix de l’arxiu 

línia. Cliquem dues vegades 

sobre ella i li donem unes 

característiques 

determinades: 

1 



En clicar dues 

vegades apareix 

la finestra 

Symbol 

Selector. 

Cliquem a 

continuació 

dues vegades 

sobre Preview. 



Ens apareix la 

finestra Symbol 

Property Editor. 

Cliquem en la 

pestanya Line 

Properties. 



En Line 

Decorations de 

Line Properties. 

cliquem en la 

fletxa que va 

cap a la dreta i 

a continuació 

cliquem en 

Properties. 



S’obri la finestra 

Line Decoration 

Editor. 

Cliquem després 

en Symbol. 



S’obri la finestra 

Symbol 

Selector. 

En Size li 

donem 18 i en 

Angle, 270. 

Després 

cliquem sobre 

Preview. 



S’obri la finestra 

Symbol Property 

Editor. 

En Offset Y li 

donem 5. 

Fem Ok 5 

vegades. 



Comencem 

l’edició de la 

capa Linia (Start 

Editing) sobre el 

Data Frame 

Europa. Amb 

l’eina Arc Tool 

de l’Sketch Tool 

tracem una línia 

corba cap al 

Regne Unit. 



Comencem 

l’edició de la 

capa Linia (1) 

sobre el Data 

Frame Europa 

(2). Amb l’eina 

Arc Tool (3) de 

l’Sketch Tool 

tracem una línia 

corba cap al 

Regne Unit. 

1 

2 

3 



Quan la línia traçada 

encara està 

seleccionada (i, per 

tant, remarcada en 

blau), la convertim 

en gràfic (Convert 

Feature to Graphics) 

des de la capa linia. 

Després la 

desseleccionem amb 

el Clear Selected 

Features de la barra 

Tools. 

1 

2 



Després cliquem dues 

vegades amb la fletxa de 

Select Elements (1) de la 

barra Tools sobre la línia 

acabada de crear i amb el 

botó dret cliquem sobre 

Properties. 

S’obri la finestra Properties 

(2). En la casella Width 

(amplària, anchura) escrivim 

el valor del Regne Unit (4,5), 

amb una xifra arredonida 

(redondeada) i li donem a 

Aceptar. El grossor de la 

fletxa representarà el valor 

del flux d’exportació des de 

València al Regne Unit.  

Fem la mateixa operació 

amb les altres fletxes que 

van a Europa, al Pròxim 

Orient i al nord d’Àfrica.  

1 

2 



Si el grossor del flux és molt ample, com en el cas de França, cal canviar el grossor de 

la punta de la fletxa: anem des de Properties de la fletxa de França a Change Symbol, 

Symbol Selector (Preview), Symbol Property Editor (Line Properties), Properties, Line 

Decoration Editor, Symbol, Preview i en Symbol Property Editor (1) canviar els valors de 

Size (donar una valor més alt, com ara 25) (2) i de l’Offser Y (la separació de la punta 

de la fletxa de la línia de la fletxa) (3).  

2 

3 

1 



Una vegada feta Europa i la conca mediterrània, procedim a fer les fletxes de la resta del món 

(data frame mon).  



Seleccionem el cercle central del Data frame Europa amb la 

fletxa de Select Elements de la barra Tools. Anem a Edit 

(barra Main Menu), despleguem la pestanya i li diem Copy (1). 

1 



Després, si cliquem sobre el data frame mon amb la fletxa de Select Elements, 

l’activem. Sabrem que està activat perquè Europa deixa d’estar en negreta (1) i la 

negreta passa a mon (2). Després, amb el botó dret cliquem sobre el marc del Data 

Frame mon, es desplega la finestra i anem a Order i li diem Bring to Front.  

3 

1 1 

2 



Després del Bring to Front. El Data Frame mon es col·locarà per damunt del Data frame 

Europa. Després fem Paste i el cercle que envoltava el País Valencià en el Data Frame 

Europa ara s’enganxa al Data Frame mon. A partir d’aquest cercle comencem a dibuixar 

les fletxes que vagen als països de fora d’Europa i la Mediterrània.   

1 



A partir d’aquest cercle comencem a dibuixar les fletxes que vagen als països de fora 

d’Europa i la Mediterrània. Atenció: cal parar l’edició de la capa linia que hi ha al Data 

Frame Europa. La capa linia (amb les seues característiques de punta de fletxa) la 

podem arrossegar i portar al Data Frame mon. Després cal iniciar l’edició de la capa 

linia, però la que està en el Data Frame mon.  



Tornem a activar el Data frame Europa i el podem davant (Bring to Front) del Data Frame mon. 

Problema: el Data Frame Europa tapa part de les fletxes traçades en el Data Frame mon. 



Què fem? Activem de nou el Data Frame mon i seleccionem les fletxes i amb el botó dret anem a 

cut. 



Després activem novament el Data Frame Europa i amb edit fem un paste. D’aquesta manera les 

fletxes es veuen com cal. Si algunes fletxes de mon xafen les fletxes d’Europa, les modifiquem a 

mà.   



Per a fer la llegenda dibuixem en linia (de mon) una línia horitzontal. A la primera li donem un 

grossor equivalent a 200 milions d’euros, a la segona, de 100 i així successivament (dependrà del 

valor del sector que hàgeu triat).  



El mapa quedarà més o menys així. Feu el comentari i l’envieu a exercici_8. 



GENERALITZACIÓ 
CLASSIFICACIÓ D’USOS DEL SÒL 

EN UN TERME MUNICIPAL 
Onda 



Onda 

Creem una Personal Geodatabase de tipus polygon amb ArcCatalog i un New Feature Class amb 
el nom del poble triat (elegido) (“Onda(2)”, en aquest cas).  



Li donem el sistema de coordenades ETRS 1989 30 N. 

Tot seguit creem una altra New feature class, però ara de tipus línia (Line features). L’anomenem 
Onda_linia (o poble x_linia). Li donem també el sistema de coordenades.  



Carreguem la capa Onda(2) en ArcMap i vinculem l’arxiu Valencia_exercici_09 o 
Espanya_exercici_09 (si el poble triat està fora del País Valencià). Start editing > Busquem, 
localitzem i copiem el terme d’Onda (des de Valencia_exercici_09) sobre la capa “Onda2”.   



Fem paste sobre la capa Onda2. Desvinculem Valencia_exercici_09 i només ens quedarà la capa 
“Onda2”, amb el terme d’Onda, sobre la qual treballarem.  



Mitjançant WMS vinculem l’ortofoto bé del portal IDEE (<http://www.idee.es/wms/PNOA/PNOA>) 
o bé de l’ICV (només País Valencià) <http://terramapas.icv.gva.es/odcv05_etrs89h30_2010> 
(província de València) o <http://terramapas.icv.gva.es/odcv05_etrs89h30_2009> (províncies 
d’Alacant i Castelló). Per a poder visualitzar l’ortofoto. Donem a Onda2 transparència. 

http://www.idee.es/wms/PNOA/PNOA
http://terramapas.icv.gva.es/odcv05_etrs89h30_2010
http://terramapas.icv.gva.es/odcv05_etrs89h30_2009


Utilitzar els WMS de vegades por resultar massa lent, així que convé descarregar-se el mapa o els 
mapes 1:50.000 que corresponen al nostre terme municipal d’estudi. Anant a 
<http://centrodedescargas.cnig.es/CentroDescargas/buscadorCatalogo.do> i descarregant el full 
PNOA máxima actualidad. 

http://centrodedescargas.cnig.es/CentroDescargas/buscadorCatalogo.do


 

Ara ja podem començar a fotointerpretar el terme municipal (per exemple 

l’embassament de Sitjar). 

Per a la fotointerpretació del terme municipal ens hem de basar en els paràmetres 

següents, propis de la classificació CORINE: 



Classe 

CORINE 

Nomenclatura 

CORINE 

Unitat 

mínima 

111 Teixit urbà continu / Tejido urbano continuo >5 ha 

112 Teixit urbà discontinu / Tejido urbano discontinuo >5 ha 

121 Zones industrials i comercials >5 ha 

122 Xarxes viàries i ferroviàries i terrenys associats >5 ha/>25m 

123 Zones portuàries / Zonas portuarias >5 ha 

124 Aeroports / Aeropuertos >5 ha 

131 Zones d’extracció minera / Zonas de extracción minera >5 ha 

132 Abocadors / Vertederos  >5 ha 

133 Zones en construcció / Zonas en construcción >5 ha 

141 Zones verdes urbanes / Zonas verdes urbanas >5 ha 

142 Instal·lacions esportives i d’esbarjo (recreativas) >5 ha 

211  Cultius herbacis de secà / Cultivos herbáceos de secano >10 ha 

212 Cultius herbacis de regadiu / Cultivos herbáceos de regadío >10 ha 

213 Arrossars / Arrozales >10 ha 

221 Vinya / Viña >10 ha 

222a Cítrics / Cítricos >10 ha 

222b Cultius arboris de secà / Cultivos arbóreos de secano >10 ha 

222c Cultius arboris de regadiu / Cultivos arbóreos de regadío >10 ha 

223 Oliveres / Olivares  >10 ha 



no existeix*250 Cultius abandonats / Cultivos abandonados >10 ha 

312 Bosc de frondoses /  Bosques de frondosas >10 ha 

313 Bosc de coníferes / Bosques de coníferas >10 ha 

321 Pastures naturals / Pastizales naturales >10 ha 

323 Matolls escleròfils / Matorrales esclerófilos >10 ha 

324 Matolls boscosos de transició / Matorrales boscosos de transición >10 ha 

331 (a) Platges, dunes i arenals / Playas, dunas y arenales >5 ha/>10m 

331 (b) Rambles / Ramblas >5 ha/>25m 

332 Sòls rocosos / Suelos rocosos >10 ha 

333 

Sòls amb escassa vegetació (erosionats) /  

Suelos con vegetación escasa (erosionados) >10 ha 

334 Zones cremades / Zonas quemadas >10 ha 

411 Humedals continentals / Humedales continentales  >5 ha 

421 Marjals / Marismas >5 ha 

422 Salines / Salinas >5 ha 

511 Cursos d’aigua (riu)  / Cursos de agua (río) >5 ha/>10m 

512 Làmines d’aigua (embassament) / Láminas de agua (embalse) >5 ha 

521 Llacunes costaneres (albufera) / Lagunas costeras (albufera) >5 ha 

*CORINE distribueix els cultius abandonats entre diverses classes i per tant no té cap número 

assignat a aquesta classe. Nosaltres li assignem el 250.  

RESTRICCIONS: 5 HECTÀREES URBÀ, PLATGES I AIGUA 
RESTRICCIONS: 10 HECTÀREES FORESTAL I AGRÍCOLA 
RESTRICCIONS LINEALS: 25 M CARRETERES, FC, RAMBLES 
RESTRICCIONS LINEALS: 10 M PLATGES, RIUS 



Per a fotointerpretar els elements poligonals que estiguen en les vores de la geodatabase 
“Onda” utilitzem el Cut Polygon Features. Podem fotointerpretar tot el polígon des de les vores 
cap a dins.  



Si ens interessa fotointerpretar cobertures centrals (sense vora)  podem fer servir el Cut, començant 
el dibuix fora de l’àrea que cal retallar i acabant el dibuix amb una línia que creue la inicial. 



Si el polígon és bàsicament lineal perquè és una carretera (o un riu), podem usar un Buffer. 
Carreguem la capa Onda_linia en la Table of Contents. Start Editing > Onda_linia >  dibuixem 
(Create New Feature) l’eix de la carretera (1) > Save Edits > Stop Editing.   



Després Start Editing > Target “Onda2” > seleccionem l’eix (que hi ha a Onda_linia) i li fem un 
buffer de tants metres com calga (cal mesurar l’ample aproximat de la carretera amb l’eina 
Measure de la barra Tools). En aquest cas 50 m i, per tant, el buffer serà de 25 m (des de l’eix 
central en cada sentit; 25 cap a l’esquerra + 25 cap a la dreta = 50).  



Després Start Editing > Target “Onda2” > seleccionem l’eix (que hi ha en Onda_linia) i li fem un 
buffer de tants metres com calga (cal mesurar l’ample aproximat de la carretera amb l’eina 
Measure de la barra Tools). En aquest cas 50 m i, per tant, el buffer serà de 25 m (des de l’eix 
central en cada sentit; 25 cap a l’esquerra + 25 cap a la dreta = 50).  



Després, sobre el polígon resultant del buffer cal fer un clip en la capa “Onda”, per evitar el 
solapament, la duplicació de un polígon sobre l’altre. Cada tros del terme d’Onda només pot 
tenir un sol ús del sòl.   



Després, si cal, amb l’Snapping (pestanya Editor, barra Editor) activat, fem un cut per eliminar la 
part del polígon lineal que resta (queda) fora del terme municipal.  



Ara que ja tenim la carretera dibuixada, anteriorment havíem dibuixat l’embassament, podem 
començar a afegir dades (añadir datos) en la taula d’atributs. Creem un camp nou (add field) 
(l’edició ha d’estar inactiva per a l’add field) de tipus Text i li diem “corine”.  



Consultem la classificació de les diapositives 9 i 10 i anem etiquetant tots els usos del sòl: 
embassament, xarxa viària, riu, etc.  



Podem començar també a assignar simbologia. Simbology > Categories > Value Field > (corine) > 
Add values > Xarxa viària, etc.  

Assignem tonalitats rogenques per a àrees urbanes, violetes per a industrials, grises per a xarxa 
viària, taronja per a cítrics (amb trama d’arbre), verdes (amb trama) per a bosc, blaves per a 
l’aigua, etc. Si assignem la simbologia a mesura que fotointerpretem el mapa –i no esperem al 
final– la  podrem visualitzar alhora que dibuixem el mapa. 

 



Per donar trames als colors cal usar el Symbol Selector i el Symbol Property Selector. 



Sempre que fem el tall (cut) hem d’assegurar-nos que el polígon complisca les restriccions del 
CORINE. Ací hi ha una Instal·lació Esportiva i Recreativa (codi 142). Segons la classificació que 
hem vist abans, cal que tinga un mínim de 5 hectàrees. Després de fer el Cut, agafem la “i” 
d’Identify de la barra Tools (1) cliquem dins del polígon (2) i mirem quina és la SHAPE area (3) 
(que és = 868136). El resultat ens el dóna en metres, per a passar-ho a hectàrees dividim per 
10000 = 86,8, per tant supera amb escreix (con creces) les 5 hectàrees. 

1 

2 

3 



Els colors que cal utilitzar són, en general: rojos per a zona urbana, verds per a muntanya i cultiu, 
blau per a l’aigua,… Es poden utilitzar trames, per a arbrat (arbolado), per a cultiu arbori i per a 
uns altres usos. El resultat final de la llegenda serà aquest.   




